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Intro

Layer Slayer will free you from the constraints of the layer stacking order in After Effects. If you have ever worked in a
moderately complex composition, you have likely found yourself drowning in pre-comps, duplicating layers like a
maniac, pasting keyframes for eternity. With Layer Slayer, you can summon a perfectly synced copy (called a “Slayer”)
of any layer you like (the “Master”). The Slayer goes wherever you need it, and the Master sends its content there
with a single click. There's no limit to how many Slayers you can create for a single Master, it's one click no matter how
complex you've made it. Think of the whole group as single magic layer that can weave its way anywhere in the
timeline at any time.



Key Concepts

Some terms and concepts to keep in mind as you read the manual.

Main Comp
The current comp of interest where you will do all your work.

Master Layer
The main layer to be referenced and synced to. The Master Layer can be edited without any
limitation.

Slayer Layer
The reference layer that syncs to a Master. There may be many Slayer Layers for a single Master
as they appear at different places in the Main Comp's layer stack. You can also add new effects
and other changes to individual Slayer Layers, depending on what you are trying to achieve.

Slayer Comp
The source for the Slayer Layers. Nested inside the Main Comp when created. It can also be used
anywhere else in the project and still syncs to the Master. Do not edit inside the Slayer Comp.

Slayer Pre-Comp
A copy of the main comp, where only the Master Layer is visible along with any other layers
specified in your Master Settings. All dependencies are present so that it is an exact match to its
counterpart in the Main Comp. The Pre-Comp is nested inside the Slayer Comp, which in turn is
used in the Main Comp or anywhere else in the project. The Slayer Pre-Comp is re-generated
every time you update the Master (So don't waste time making changes there!). 

Family (or Group)
An inter-connected group of all of the above.  A family is all the items and layers that will be
affected by changes to a given master layer. 

Knock Out
In order to avoid overlapping the same content (thereby avoiding potential blending
inconsistencies), a slayer layer can be “knocked out” by any other member of the same family.
This means the layer is muted (visually) when another family member is active at the same point
in the timeline.  The Master layer  is always knocked out by Active Slayers which overlap it in the
timeline.

Active
When a Slayer is “Active” it is capable of knocking out other Slayers, if not active, the Slayer is
not visible, and will not knock out other Slayers.

A Slayer Layer is considered “Active” if all of the following apply:

• The layer is enabled (eyeball button)

• If soloing is being used in the comp, the layer is one of the solo layers 

• The layer spans the current time

• The “Active” setting under Slayer Options effect is “On”.

The Active setting under Slayer Options will be automatically set to “Off” if the layer is currently
being Knocked Out by another Slayer in the same group.



Buttons

The main functions of Layer Slayer. These buttons provide everything you need to set up your layers. In general, you
can select either a Master or any of its Slayers to indicate the family you want to update, add to, switch on, etc.

Opens the Info and Settings panel – wherein you will find a plethora of choice. Probably how you found
this manual.

Creates a new Slayer Layer connected to the selected Master layer. You can add as many Slayers as you
want for any layer in your comp. If adding to an existing group, it will be first updated, then another Slayer
added. You can also duplicate an existing Slayer Layer instead of using the Create/Add button (it will be
slightly faster but will not include the update). 

Updates all Slayers connected to the selected Master layer. All properties, effects, settings and more
become perfectly synced.

Options:

• Hold down SHIFT to update all Layer Slayer families in the current comp.

• Hold down CMD (Mac) or CTRL (Windows) to update the group and restore expressions and Time
Remapping in each Slayer Layer in the selected group. The name of the Slayer Layer will also be
restored to the default format – based on the master name.

• Hold down SHIFT + CMD/CTRL (Mac/Win) for both.

Clears all the Slayer Layers, pre-comps and effects for the selected family. The Master Layer is left
untouched (except for the removal of the custom effects).

Options:

• Hold down SHIFT to clear all Layer Slayer families in the current comp.

Switches to toggle the visibility, solo, lock, and shy settings of all Slayers belonging to the same family as
the selected Slayer or Master.

Options:

• Hold down SHIFT to apply the toggle to all Slayers in the comp rather than just the selected
family.

• Hold down CMD/CTRL (Mac/Win) to apply the toggle to the Master layer as well as the Slayer
layers.

• Hold down SHIFT + CMD/CTRL (Mac/Win) for both.



Adds an expression that creates a live-link for the selected property across all Slayers in the group. When
you update, the property is then synced in real time - no need to click update again in order to see your
changes. You can use this for any property in any layer of the comp that might affect the master layer (e.g.
cameras, adjustment layers, mattes…).

Options

• Hold down SHIFT to remove the Live Link from selected properties. If a user-specified expression
was used under “//YOUR EXPRSSION HERE:”, it will be restored as the property's main expression.

Settings
You can customize how the master layer is pre-comped as well as how the pre-comp behaves when it becomes a
nested layer in the main comp (i.e Slayer). These behaviours are controlled by custom effects that sit in the Master
Layer and Slayer Layers (info: Layer Slayer Pseudo Effect). Their default values, which will be used in every new
instance, can be set in the Default Settings tab of the Help Panel. 

Layer Slayer Master Settings

These settings are added to every newly created Master Layer. They determine which aspects of the Master layer are
used and which are left out of the pre-comp. They are persistently applied to the pre-comp each time you create a
new Slayer (✚) and when updating (↻), therefore you can change these at any time and all the Slayers in the group
will reflect the change.

▾ Track Matte 

▶ None: If the master is using a track matte, it will be disabled for the slayer. Useful if you want to access the un-
matted contents of the master.

▶ Normal: The current track matte settings  of the Master will be used in the Slayer.
▶ Inverted: The Slayer will use the inverse of the Master's current track matte (e.g. if Master track matte is set

to  “Luma Matte” , the Slayer precomp will use “Luma Inverted Matte” ).  
If checked, the pre-comp will retain any track matte settings for the master layer in the main comp.

☑ Use Parent

If checked, the pre-comp will retain any parenting settings for the master layer in the main comp.

☑ Collapse Transformation

If checked, the pre-comp will enable “Collapse Transformation” which prevents pre-rendering in the pre-comp. You
may want to use this if...

☑ Use Adjustment Layers

If checked, the pre-comp will leave any active adjustment layers on. Use this if an adjustment layer is providing an
effect that you want to show through in the Slayer layers.



☑ Active Camera

If using 3D layers or plugins leave checked in order to use the comp's active camera setup in the pre-comp. If
unchecked, all cameras will be disabled in the pre-comp and Slayer layers will show the master content without
rendering through the camera.

☑ Lights

Similar to the active camera setting, check this to use lights in the Slayer pre-comp.

Including Additional Layers in the Sync

You can tell Layer Slayer to enable any other layer in the comp in case you wish to group it together with the master.
This might be useful to reduce the number of Slayer groups needed to achieve a given effect, if you want to nest only
part of your comp inside another one, or to maintain a pre-render comp of particularly heavy layers so you can
periodically update a proxy. Or you may be trying to isolate the blending result of two or more layers without
involving the others.

To include any layer with your master update:

1. Add a Layer Control effect to your master layer. You can find it under Effects > Expression Controls > Layer
Control.

2. Rename the Layer Control to “LS – Include”.

3. Select the layer you want to include from the Layer pulldown options. Note that selecting a layer that is
already a slayer will be ignored in the update.

4. From now on, when you update the master layer, the selected layer will be baked into the Slayer Layers
connected to that master.

5. The “Included” layer will not be affected or have any special behaviour in the Main Comp. Only the Master will
be knocked out by its Slayers. 

To stop including the extra layer:

Remove the “LS – Include” effect or set the Layer pulldown to “None”.

Slayer Options 

These settings affect the behaviour and interactions of the Slayer Layers in the main comp. They are added as an effect
to new Slayer layers when you create them using ✚. You can change these settings anytime after the Slayer was
created, and different Slayer layers from the same Master can have different behaviours. These settings will be
respected however you set them in each layer and will not be re-applied when you update (↻). However, you can
restore missing expressions, or remove extraneous ones, by pressing CMD/CTRL (mac/win) + ↻ .

☑ Active

Determines whether this Slayer Layer is currently an active player in its Slayer Group. The value of this setting can be
keyframed, but is also influenced by an expression that takes into account:

• The Knock Out setting of the current layer
• The Active state of other Slayers in the group. 



Conversely, other Slayers will be affected by the Active setting of the current layer, depending on their Knock Out
setting. 

A Slayer is considered “Active” by other Slayers if:

• The layer is enabled (eyeball button).
• Its time range includes the current time.
• “Active” is currently set to “On” (This can be keyframed over time but will also be driven by an expression

that considers the “Active” state of other layers).

When Active is “Off” the Opacity of the layer is forced to zero by an expression. Other than this, you can freely set the
value and animate the layer Opacity. You can even apply your own expressions under “//YOUR EXPRESSION HERE”
(Before you animate the Opacity of the Slayer, think about whether it might be a better idea to animate the Master
Layer's Opacity instead).

The Active setting makes it easier to get the most out of a single Slayer Layer. It allows you to use it over more than
one time range without having to duplicate the layer or add another Slayer to the family. Only add new Slayers if you
need them at another layer position in the hierarchy.

▾ Knock Out

How the Slayer gets knocked out by other Slayer layers of the same family (siblings). One of the following:

▶ None:  Layer does not get knocked-out. Visible for its entire active range in the timeline.

▶ Above:  Layer is knocked-out by any sibling found above this layer, that is active at the current time.

▶ Below:  Layer is knocked-out by any sibling found below this layer, that is active at the current time.

▶ All:  Layer is knocked-out by all siblings that are active at the current time. 

When a Slayer is Knocked-Out, its Active state is forced to “Off”. That layer will not Knock Out other Slayers until the
Active state is “On”. A slayer's Knock Out state takes into account the other layers' position in the layer stack (above,
below, etc…) AND the other layers' Active setting. If a Slayer's Active state is set to “off” at the current time,  setting
does not take into account the knock out setting of other the other slayers. Therefore if a slayer set to “All” is above a
slayer set to “Above”, for example, they will both be knocked-out.  Note that the master layer is always knocked out
by active Slayers.

▾ Timing Sync

Uses time remapping to ensure the slayer's timing always matches the master layer. The settings will affect how to
sync the slayer in regions where the master is inactive or trimmed.

▶ None:  No Time Syncing will be applied. The Slayer timing is completely determined by the layer's start time

and duration. *

▶ Normal:  A one to one Time Sync will be applied. This ensures that the Slayer Layer is always showing the

same frame that the Master would be showing – no matter how you've trimmed it into the timeline. This
allows for  faster manipulation and shifting of the Slayer Layer. 

▶ Freeze:  Forces an exact timing match to the Master layer. If the slayer is active when the master is not, it

holds a freeze frame of the first or last frame of the master layer's active region. For example, changing the



out point of the master layer will change the freeze frame of the slayer.

▶ Loop:  Forces an exact timing match to the Master layer. If the slayer is active where the master is not, it

loops the master layer's active region. For example, changing the out point of the master layer will change
the number of looped frames in the slayer. The loop is always relative the master's active region so that the
two layers are synced where they overlap in the timeline.

*Switching to and from “None” may require an update with reset (hold down CTRL/CMD and press update) for the
change to take full effect. This will add or remove the Time-Remap expression as needed.

☑︎ Lock Transform

Applies expressions to the Slayer's transform properties that keep it correctly sized, centered, and aligned with rest of
the comp. Allows you to work freely without needing to lock the layer, which can be helpful when animating effects
but where you want to prevent the slayer from being accidentally moved, rotated, etc... 

You can restore or remove the Lock Transform expressions by pressing CMD/CTRL (mac/win) + ↻.

Restoring Expressions

The Slayer Options settings use expressions to achieve their desired effects. Layer Slayer adds the necessary
expressions as per your default settings in the Help Panel to every new Slayer. You may find that switching some
settings in the Slayer Layer after you've created it leaves you without the necessary expressions OR with expressions
that you no longer need (for example, changing the Timing Sync from “None” to “Loop”). In this case you'll want to
do an update with the “Reset” option:

1. Select the Master or any Slayer in the family.

2. Press CTRL/CMD (Win/Mac) + ↻ (update). 

3. For each Slayer in the family, expressions will be added, replaced or removed according to the settings you've
chosen for that Slayer layer under Slayer Options. The layer name will also be reset to the default naming of
the Slayer.

Renaming, Duplicating and Other Magic

Renaming

In General, you can rename your Main Comps, Master Layers and Slayer Layers however you like. This way, you can
keep using your own naming conventions and Layer Slayer will take care of the rest when you press ↻. The script will
generally insist that the comp has a unique name in the project, and that the master layer has a unique name within
the comp. Also, in some cases renaming the sLaYeR comp item in the Layer Slayer folder in the project panel may
cause some confusion. But then again… that would be asking for it ;)

Master Layer Duplication

The flip side of our robust naming flexibility is that when you duplicate a comp containing Master-Slayer groups, there
is some ambiguity.  In the duplicate comp, you have what looks like a master layer – with the familiar Layer Slayer
Master effect and the special comment tag – as well as any Slayers that you had created in the original comp.
However, the Slayers still belong to the master in the original comp. The master sitting in the duplicate comp is just a



copy - It is not connected to any Slayers...yet.

You will need to clarify how Layer Slayer should treat the Master Layer in the duplicate comp. If you have duplicated a
comp with Master Layers in it, the first time you click update on any Master Layer in the new comp, a dialog will
appear with three options:

Switch control to this Master Layer

Removes any Layer Slayer effects and comment tags from the Master Layer in the original comp, thereby removing its
master status. Slayers sitting in the original comp and their duplicates in the new comp will now be connected to the
master layer in the new comp.

Leave Master control in original comp

Removes any Layer Slayer effects and comment tags from the selected layer in the new comp. Any Slayers that
appeared to belong to it will remain connected to the Master Layer in the original comp.

Make a second independent Master-Slayer group

The new Master gains control of any related Slayers inside the duplicate comp. The original Master keeps control over
Slayers in the original comp. If Slayers are being used outside the original and duplicate comps, the master in the
original keeps control over them. You can manually change control of the external Slayers to the new duplicate master
by Alt-dragging the new “sLaYer” comp from the Layer Slayer Folder in the project panel. 

Select the best option and click “OK”.

Pre-Comping

If you pre-compose a Master Layer using After Effects' built in Pre-Compose Layers function – It is recommended you
run an update  ↻ immediately after. There are two options:

“Leave all attributes...”: Update the main comp - Master stays in original comp.

If you select “Leave all attributes in [your comp]”, then your Master Layer remains active inside the main comp. It is
now a nested comp, but the layer still contains the necessary effects and comment tags to keep going as a master
layer. The connection to the Slayer Layers is maintained and any visual changes that occurred when you pre-composed
will soon appear in the Slayers. 

“Move all attributes...”: Update the new comp - Master control is switched to new precomp.

If you select “Move all attributes to new composition” when pre-composing the Master Layer, then all the Master
control effects and comment tags are moved to the newly formed pre-comp. The Master Layer now lives in the pre-
comp. If you selected Slayers to be pre-comped with the Master they will act as normal Slayers in the new Pre-Comp. If
there any left behind in the original comp, they will still act as external Slayers for the master that has now moved to
the new pre-comp. Thus, if you select them and press  ↻, you'll be directed to go and update from the main comp (i.e
the new Pre-Comp). 

Layer Slayer Pseudo Effect

A pseudo effect is simply a collection of familiar looking controls that appear in your layer's effects. They are used to
store settings to be used by the script and expressions. Unlike normal effects (i.e plugins), they do not affect the
image directly. Layer Slayer uses pseudo effects in order to offer the smoothest experience and cleanest interface



possible.

It is not necessary, but highly recommended to install the pseudo effects using the “Pseudo Effect” tab in the Info and
Settings window. Installing will remove the “Missing:” label that occurs in CS6 and earlier and help improve Layer
Slayer's performance in all versions of After Effects. 

Layer Slayer will still function properly if you don't install the pseudo effects by using an alternative method of
installing them.

To install pseudo effects in PresetEffects.xml

You will need permissions for the After Effects application folders in order to complete the installation this way.

1. Open the Info & Settings panel.

2. In the “Pseudo Effect” tab check that the button says “Install”.

3. If the button says “Install”, click the button to add the pseudo effect to the PresetEffects.xml file. If the
button says “Uninstall”, it means the pseudo effect is already present in the PresetEffects.xml file.

If all else fails…

If none of the above methods is available to you (very unlikely!) and you simply can't use the pseudo effect, Layer
Slayer will use the following default values for anything that would have been set via the pseudo effect controls (see
above for their descriptions).

Master Settings

Track Matte: Normal
Use Parent: Yes
Keep Adjustment Layers No
Collapse Transformation No 
Active Camera: Yes
Lights: Yes

Slayer Options

Active: Yes
Knock Out: Above
Sync Timing: Normal
Lock Transform: Yes

Importing Projects

If you are importing a project that uses Layer Slayer – please use the “Import Project” function provided through the
Help and Settings Panel. This will ensure that everything lands in the right place and the script will be able to keep
track of all the elements. If you import using the standard AE methods, some connections may be broken and Layer
Slayer will treat your imported comps as “Normal”  (as though they are not special Layer Slayer comps).

To import a Layer Slayer enabled .aep into another project:

1. Info & Settings > Import.

2. Click the “Import AE Project” button.



3. When prompted, choose the .aep file you want to import into the current project and click “OK”.

There should only be one Layer Slayer Folder in the project containing all the Slayer Pre-Comps used in the imported
project and the current project.

Sharing Projects

You don't need Layer Slayer in order to continue working on a project or comp that used it in the past. 

My Collaborator/Client Has Layer Slayer:

Great! They can just open up the project and they are ready to continue working on it with all the slick magic that
Layer Slayer provides. There is no guarantee that older versions of Layer Slayer will work well with projects created
using newer ones. Make sure they are using the same version as you or later.

My Collaborator/Client Does Not Have Layer Slayer:

The Poor soul… maybe they should just get it ;) But even if not, have no fear: After Effects projects that were built
using Layer Slayer will still work perfectly well on a workstation without Layer Slayer installed. An expert After Effects
user will easily see and understand the slightly different pre-comping methods used to build the project. Just in case,
here are a few useful things to know for anyone tackling a Layer Slayer project without the script. 

• All the Layer Slayer elements are contained in the “Layer Slayer” folder of the project.

• Comps inside the “Pre-Comps” folder are only used as nested comps inside the “sLaYeR” comps, found at the
top level of the Layer Slayer Folder.

• The “sLaYeR” comps are then used as the duplicate layers inside the original main comp and occasionally in
other comps. 

They won't have access to the update function, so they will have to update any changes to the master layer the old-
fashioned way. The Slayer Layers in the main comps are more like pre-renders than like duplicates of the master layer.
Therefore you will need to find the master layer inside the appropriate “Pre-Comp” and copy and re-apply the changes
there. The advantage is that you only need to paste into one place that looks just like the original context  - and all the
references inherit the change since they are nested.

To update a change to a master layer without using Layer Slayer:

1. Copy the changes from the master layer in the main comp -  the same as if you'd never heard of Layer Slayer.

2. Instead of pasting the change directly into the duplicate layers, first find the associated Pre-Comp in the “Pre
Comps (Do Not Use)” folder:

• Find it by name: [Main Comp name] > [Master Layer name] – Pre-Comp.

• Find it by double clicking a slayer layer (“- sLaYeR”), then double clicking the nested comp inside it.

3. Paste the changes to the same master layer in the Pre-Comp.

4. If the change depends on newly created layers, different track matte settings, etc... other than the master
layer, you will need to paste those layers into the Pre-Comp as well.

Once you've applied all your changes inside the appropriate Pre-Comp, they will show up in all the Slayer Layers linked
to that Master Layer – which luckily still saves you the work of re-applying them to many different duplicates. So there



is still some advantage to a project that was built with Layer Slayer – even if you can no longer update it automatically.

Changing the name of a main comp or master layer may affect live link expressions. 

How to Break Layer Slayer

Layer Slayer does everything possible to avoid imposing new rules on how you work. For example, you can keep
renaming and duplicating layers and comps however you like (LS will try to prevent duplicate naming...). It will
tenaciously keep everything up to date by spotting and fixing ambiguities on every update. That being said, if you
really try, you can break the system by some combination of the following bad ideas:

• Editing or removing the comment tags that look like “[Layer Slayer...]”.

• Duplicating or moving comps placed in the Layer Slayer folder and its subfolders.

• Editing any control, text, or expression that says “Do Not Edit”.

• Importing a project that used Layer Slayer without using the provided import button.

Now that you know how to break Layer Slayer, you also know exactly how to keep it running smoothly ;)

Troubleshooting

The Slayer Layer seems out of sync with the master.

• If you are driving a property that impacts the master layer with an expression that uses a random number,
such as “wiggle(...)” or “random()”, the slayer may have a different result from the master. To make sure the
randomness matches between slayer and master, use the “seedRandom(x)” command in your expression,
where x is a number that will be the same in both comps (for example, the layer index will be different, so do
not use “seedRandom(thisLayer.index)” as the random seed). Another option is to use  to contain the

original expression inside the Layer Slayer Live Link expression. This way, the Pre-Comped property will simply
take the value of the original. 

• You may be in a situation that requires a “strict” slayer update. Select the master layer and hold down
CMD/CTRL and press update. This will rewrite any broken or missing expressions and remove or add time
remapping according to your Slayer Options (see above).

Now go! Be free of Layer hierarchy !! 

Layer Slayer Script for After Effects

by David Seitz

© 2016

eviltwintools@gmail.com


